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ABSTRACT
Release 6.12 of the SAS System for Personal Computers provides support for Microsoft Windows (version 3.1 using Win32s
technology, Windows 95, Windows NT), and
®
OS/2 (Warp). With this release, the SAS
System incrementally improves both its user
interface and its interoperability with other
PC applications. This paper discusses both
new features and incremental enhancements to the user interface. This paper also
describes the SAS System for Windows 95
and Windows NT 4.0, detailing the new user
interface features that are consistent with
the look and feel for Windows 95 and Windows NT 4.0. The SAS System Viewer, production for 6.12, is described as is the GUIbased SETUP program.
Interoperability
topics include Windows Explorer integration,
electronic mail, Lotus Notes, OLE, OBDC,
and access to external DLLs. This paper
also discusses the support provided by the
SAS System for Windows NT.

INTRODUCTION
Release 6.12 of the SAS System under
Windows and under OS/2 is a complete implementation of the SAS System. This release takes advantage of the 32-bit performance of the operating system. For example, the following operating system improvements over 16-bit environments will
positively affect your SAS programs:
-

-

-

the 32-bit operating system enables
your SAS programs to execute faster
the improved fault isolation capabilities
ensure that if another application fails,
your SAS session is not affected
the additional resources reduce resource contention, so your SAS programs execute more efficiently
the redesigned interface in Windows 95
and Windows NT makes SAS easier to
use.

This paper provides an overview of the new
Release 6.12 enhancements. You should
view this paper as an introduction but you
should refer to the SAS Companion for the
Microsoft Windows Environment and the
OS/2 Environment: Changes and Enhancements of the SAS System for more details
as well as online documentation, which is
more extensive in Release 6.12. Release
6.12 continues to provide incremental enhancements to the user interface and
interoperability areas of the SAS System. In
other areas such as the SAS System Viewer
and the SETUP application, new features
have also been added.

THE SAS SYSTEM VIEWER
The SAS System Viewer is a
freely redistributable application
for viewing and printing files that
were created by the SAS System.
The Viewer provides a quick and convenient
way to view the contents of a SAS data set
or catalog without invoking the entire SAS
System, or even having the SAS System
installed on your computer.
When you install the SAS System Viewer
under Windows 95 or Windows NT 4.0, the
Setup procedure automatically updates the
Windows registry to associate the Viewer
program with SAS data set files (.SD2),
catalog files (.SC2), and other files (.SAS,
.LOG, .LST) associated with the SAS System. When you click on the right-mouse
button from an Explorer view of one of
these files, you can select SASView to
launch the SAS System Viewer
The SAS System Viewer lets you view the
following types of SAS files:
•

SAS data sets (.sd2 and .ssd files), up to
two gigabytes in size, generated by Release
6.04 and later of the SAS System for Windows, OS/2, or DOS. These data sets can
be compressed and/or encrypted. (If you

attempt to access an encrypted data set,
the SAS System Viewer prompts you for the
read password.)
•

SAS catalogs (.sc2 files) generated by the
SAS System for Windows or OS/2.

•

SAS programs (.sas files), output listings
(.lst files), logs (.log files), text files (.txt
files), and RTF files (.rtf files).

•

Files created by SAS Institute's JMP product
(.jmp files) that reside on a local or network
disk.

•

If you have the SAS System for Windows
installed with SAS/CONNECT, you can also
view cross-platform data sets and catalogs
(VMS, Macintosh, UNIX, OS/2, Windows,
and DOS) that you can access from a disk,
file server, or network using the HTTP and
FTP network protocols.

Figure 1. The SAS System Viewer, displaying the
contents of three SAS System files: a catalog, a SAS
program, and a dataset.
The SAS System Viewer is primarily a
“Quick Viewer” like those provided by other
software vendors to support browsing of
program files. A Quick Viewer does not require the entire software application and as
the name implies, can be used more quickly
than the complete application.
The SAS
System Viewer supports many other fea-

tures as well.
Viewer you can:
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•

View SAS data sets and SAS catalogs in a
grid format. You can view SAS files that
have been created using the SAS System
Release 6.04 or later. You can also view
SAS files created by versions of the SAS
System that run on other platforms.

•

View a SAS data set or catalog by dragging
and dropping its icon on an icon representing the SAS System Viewer, or on an existing instance of the Viewer.

•

View and edit SAS programs, text files, LST
files, LOG files, and RTF files.

•

Print the contents of any SAS file that you
can view.

•

View multiple SAS files within a single instance of the Viewer.

•

Sort your view of a SAS file by column by
selecting a cell in a column and then selecting a sort option from the View menu.

•

Subset the data (using a WHERE clause)
displayed by the viewer by selecting Where
from the View menu (or pressing Ctrl-W).

•

Email a copy of all or selected grid cells
using a MAPI-compliant mail program by
selecting Send from the File menu.

•

Resize columns and rows by grabbing and
dragging the separator between the headers.

•

Copy the entire table, column, row and
block selections to the clipboard.

The SAS System Viewer is shipped with the
SAS System. You can always download the
latest version of the SAS System Viewer
from SAS Institute's World Wide Web site
or FTP site on the internet:
WWW: http://www.sas.com
The SAS System Viewer is also available in
the download section of the Technical Support area at:
FTP: ftp.sas.com/techsup/download/

IMPROVED GUI FEATURES
GUI enhancements to the Release 6.12
SAS System continue the trend to provide a
more native look and feel familiar to PC users. Some of the new GUI features include
a print preview utility, rich text support, additional toolbar support, Program Editor enhancements, and Windows 95 support.

Print Preview
To see how the contents of a window will
appear as printed output, select the window
you want to preview and then select Print
Preview from the File menu (or click the
Print Preview tool bar button).
In the Preview window, you can use the
Next and Previous buttons to navigate
through the pages to be printed. The current
page number and total number of pages are
displayed at the bottom of the window. You
can also magnify your view of the current
page (by 100%) by clicking Zoom, or by
simply clicking inside of the page. To reduce your view, click Zoom or inside of the
page again.
In the Print Preview window, you can navigate by using the following shortcut keys:
Key

Full Page mode action

Zoom mode action

PgDn

Advance to next page

Scroll down on current page

PgUp

Back to previous page

Scroll up on current page

Ctrl-PgDn none

Scroll right on current page

Ctrl-PgUp none

Scroll left on current page

Ctrl-Home Go to first page

Go to first page

Ctrl-End

Go to last page

Go to last page

A new command, DLGPRTPREVIEW, can
be used to invoke the Print Preview window

Toolbar support
The SAS System uses industry standard
tools on the default toolbar. The Tool Editor
browser contains more tools for you to
choose from when you create custom toolbars. You can choose to display the SAS
toolbar with either large or small tools.
Tooltips provide concise help information for
the tools on the SAS toolbar, the command

bar, and the status line. The tooltips are displayed as you move your mouse cursor over
these controls. Tooltips are additional detailed help that is displayed on the status
line. The Tool Editor allows you to modify
tooltip text as you modify your default tool
settings.

Program Editor Enhancements
You can use the mouse (or the SHIFT key
in combination with the cursor movement
keys) to select text. The marking of an area
of text continues until you release the
mouse button or press a key that is not a
cursor movement key (or release the SHIFT
key). To select all of the text in the active
window, choose Select All from the Edit
menu. Here are some advanced text selection methods (new for Release 6.12):
-

Double-click on a single word to select
it. To select an entire line, hold down
the CTRL key as you double-click on
the line you want.

-

Use the ALT key as you hold down the
mouse button and drag the mouse to
select a rectangular block (or column)
of text.

-

Use the SHIFT key in combination with
the mouse button to select the text
between the current text cursor and the
position in the text where you click.
(You can use this feature only within
the current page.)

-

If characters are marked and you start
typing text, the marked area is replaced
with the new text. This occurs even if
you have moved the cursor away from
the marked area. See Using the Clipboard for information about marking
and copying text with a mouse.

Rich Text Format Support
Beginning with Release 6.11 for Windows,
two new TrueType fixed pitch fonts are provided: SAS Monospace and SAS Monospace Bold. These fonts contain several
extended ASCII line drawing characters in
positions that are normally undefined in an
ANSI font. Using these line drawing char-

acters with the TABULATE procedure provides a smooth line drawing capability resulting in tabular output that is more visually
appealing.
The Sasfont bitmap font displays faster and
looks better on the display, so it is the default display font when you install the SAS
System. The SAS Monospace font looks
better in printed output and scales to many
point sizes, so it is the default printer font.
For similar reasons, the SAS Monospace
font is the default font used in the Rich Text
Format (RTF) clipboard format. The RTF
clipboard format, available since 6.11, allows you to copy selected text and tables to
the clipboard and to paste them into other
applications while preserving the correct
appearance. This allows you to copy a table
generated by PROC Tabulate into Microsoft
Word to produce an aligned table in the
Word document. RTF uses the SAS Monospace TrueType font when the default display font is either Sasfont or SAS Monospace. Otherwise, RTF uses the default display font.

be overwritten without prompting you with a
confirmation dialog.

Cursor Control
A new command, WHIDECURSOR, suppresses the display of the cursor in SAS
windows that do not allow text input, such as
those in SAS/ASSIST, SAS/EIS, and
SAS/AF software. With syntax: WHIDECURSOR <ON | OFF>, if no argument is
specified, the command toggles between
hiding and displaying the cursor. The argument ON hides the cursor, while OFF
displays the cursor.

Windows 95 Support
The SAS System for Windows,
Release 6.11 TS040 carries the
Designed for Windows 95 logo. It
has been tested by an independent
testing firm to verify that it meets a set of
guidelines that are meant to ensure that the
application operates well under and integrates tightly with Windows 95 (and NT 4.0).
In addition, the entire SAS System supports
long filenames, Universal Naming Convention (UNC) names and shortcuts.

You can use the Save As dialog to create
RTF files containing the content of text windows.

APPLICATION INTEGRATION
A new command, WRTFSAVE, saves the
contents of the current text window to an
RTF file. It can be used with syntax like:
WRTFSAVE "filename" <NOPROMPT>.
The command performs the same action as
the Save As dialog when you choose RTF
from the Save file as type list; however,
WRTFSAVE saves the file without displaying an intermediate dialog.
Filename is a required argument and can
include a file path. If you specify a filename
without a path, the file is saved in the current SAS working folder. The WRTFSAVE
command does not automatically append a
".RTF" file extension; if you want the resulting filename to end in ".RTF", be sure to
include it as part of the filename that you
specify.
NOPROMPT specifies that if a file with the
same filename already exists, that file will

With each successive release, the SAS
System has provided increased application
integration through several methods. The
SAS System supports named pipes, unnamed pipes, DDE, the system clipboard,
Media Control Interface (MCI), ODBC, external DLL access, the ability to support import and export of graphics to and from
common PC file formats, support for electronic mail, Lotus Notes, and full support of
OLE 2.0.

Windows Explorer Integration
The SAS System integrates well with the
Windows 95 and Windows NT 4.0 Explorer
since the installation process for Windows
registers all of the SAS System file types.
Each file type has a unique icon, as shown
below.

Catalog
Catalog

Dataset
Dataset

SAS
SASProgram
Program

Figure 2, Standard SAS System Icons
When a SAS System icon is selected from
the Windows Explorer, an appropriate action
for that type of file is performed by the SAS
System or the SAS System Viewer. As
shown below, the Windows 95 and Windows
NT 4.0 Explorer makes these actions available to the user.

e-mail that you send from within the SAS
System, either interactively or using the
DATA step. Although you can send e-mail
interactively by using the Send Mail dialog
provided by the SAS System, note that email file attachments are not supported
while using SMTP. A key benefit of SMTPbased mail is that it does not require a client
e-mail package in order to process mail,
unlike VIM or MAPI e-mail protocols.
The Send Mail dialog allows you to enter a
note describing the mail message. Data and
reports, which are the actual contents of the
messages, are sent as attachments. Attachments are files that you saved previously.
When you are using an e-mail package that
supports MAPI under Windows NT or Windows 95, the SAS System uses the native
e-mail dialog. This dialog allows you to attach the contents of the current SAS window.

Figure 3, SAS System Contents in the Windows
Explorer

E-mail Support
E-mail support is available interactively
through the Send Mail dialog or programmatically through the DATA step or SCL.
This implementation supports both industry
standards VIM (Vendor-Independent Messaging) and MAPI (Messaging Application
Programming Interface). Most popular email packages provide support for either
VIM or MAPI.
Support for using an SMTP (Simple Mail
Transfer Protocol) server to send e-mail
from within SAS is experimental for Release
6.12. The EMAILSERVER System Optionspecifies the SMTP server to use when
sending e-mail through SAS. This option is
valid as part of your configuration file, or the
SAS System invocation. This option has the
syntax: -EMAILSERVER host.domain.net,
where host.domain.net specifies the name
of the SMTP server through which to route

Figure 4, Sending e-mail with an Auto-attachment
You can also access e-mail through the
FILENAME statement using the Device type
of EMAIL. Additionally, you can embed a
set of directives in put statements to allow
even more flexibility when writing a data
step that conditionally sends multiple e-mail
messages.

World-Wide-Web Integration
The SAS System supports integration with
the world-wide-web in several ways.

Through SAS System SETUP registration of
MIME types, SAS data referenced in web
pages (as shown in the example below) are
able to use the SAS System or the SAS
System Viewer to display themselves if selected. Post 6.12 updates of the SAS System Viewer will support viewing SAS data
embedded In web documents within the web
browser window. At present, this support is
available in separate application windows.

associated with URLs in the Windows registry.

Lotus Notes
The SAS System provides an access engine, NOTESDB, which allows you to add
new notes documents to an existing Lotus
Notes database. You can use the DATA
step or SCL to populate the Notes database.
You do not need to have Notes running to
access it from the SAS System, but you
must have a workstation copy of Lotus
Notes installed on your machine with a valid
user ID certification.
DATA step or SCL code that interacts with a
Notes database generally uses the following
components:
•

A FILENAME statement with the NOTESDB device-type keyword

•

PUT statements that contain data directives and the
data to place in the Notes database

Figure 5, Accessing SAS System data from a web
page

•

PUT statements that contain action directives to
control when to send the data to the Notes database.

The SAS System can function well on a web
server and service web-based computing
requests. The output of these requests can
be generated in a format that is understood
by web browsers (HTML) for complete integration into a web-based computing model.

OLE Support

In addition, a new command, WBROWSE,
invokes the default web browser, which displays
SAS
Insititute's
home
page
(http://www.sas.com) by default. If you
specify a url (uniform resource locator), then
that location is displayed instead. Note that
you must enclose the URL in double quotes.

OLE 1.0, which the SAS System under
Windows has supported since Release 6.08,
allowed you to link and embed OLE objects
into SAS/AF FRAME entries and SAS/EIS
applications. OLE 2.0, which Release 6.12
supports, provides many new features that
you can use to enhance your SAS/AF
frames and SAS/EIS applications. Note that
the SAS System under Windows (and OLE
2.0 in general) still supports all the features
from OLE 1.0.

Another command, DLGWBROWSE, invokes a dialog in which you can specify the
location of your preferred web browser. The
browser you specify will be invoked when
you click the Browse tool bar button or enter
a URL (uniform resource locator) in the
command bar. Use of this command by
Windows 95 and Windows NT 4.0 users is
optional, since on these platforms the SAS
System automatically uses the web browser

OLE is a means of integrating multiple
sources of information from different applications into a unified document. These objects can include text, graphics, charts,
sound, video clips, and much more.

The OLE 2.0 features supported by the SAS
System under Windows include: visual editing, drag and drop, OLE automation, OLE
custom controls, object conversion, and
OLE automation server. Since Release
6.11, the SAS System has been able to
perform as an OLE automation server. Previously an experimental feature of SAS, this

is now a production-level capability in Release 6.12.
For more in-depth description of the OLE
support available in the SAS System, refer
to the paper “OLE and the SAS System for
Windows Release 6.12”.

SAS ODBC Driver
The SAS ODBC Driver for the SAS System
allows third party ODBC compliant Windows
applications, such as Microsoft’s Excel or
Visual Basic, open access to SAS data sets.
The SAS ODBC Driver is a multi-tiered
driver meaning that it does not directly access SAS data sets but rather communicates with either a local SAS ODBC server
or a remote SAS/SHARE server. The SAS
ODBC Driver does not connect to a
SAS/CONNECT single user server.

SAS/SHARE*NET
SAS/SHARE*NET software is added to a
SAS/SHARE server to allow third party
ODBC compliant Windows applications,
such as Microsoft’s Excel or Visual Basic,
open access to remote SAS System data
sets in shared read/write mode. When used
in conjunction with SAS/ACCESS software
on the server machine, the SAS/SHARE
server becomes a read/only gateway for the
ODBC client applications to the wide variety
of data supported by the various
SAS/ACCESS engines.
The SAS/SHARE*NET software provides
the same SAS ODBC Driver software that
comes with the base SAS System in addition to server side licensing that enables
SAS/SHARE servers to support

Accessing External DLLS

SAS System servers transparently handle
all cross architecture issues such as floating
point data translation between different
hardware/OS platforms. The same SAS
ODBC Driver comes included with either the
base SAS System or with SAS/SHARE*NET
software. The local SAS ODBC server also
comes with the base SAS System and allows access to local SAS data. To access
SAS data remote from the local machine,
you use the SAS ODBC Driver to connect to
a SAS/SHARE server that has the
SAS/SHARE*NET software installed.

You can access external DLLs through the
DATA step or SCL with the MODULE family
of SAS call routines and functions. This
functionality allows you to access either external DLLs that you create or DLLs that you
purchase. You can even access operating
system DLLs. To use, you create a
SASCBTBL attribute table that describes
the DLL routine you want to access.

When
used
in
conjunction
with
SAS/ACCESS software on the local or remote server machines, the SAS ODBC
Driver serves as a read/only gateway to the
wide variety of DBMS data supported by the
various SAS/ACCESS engines. The SAS
ODBC Driver supports both local and network DDE and TCP/IP for connection to local ODBC or remote SAS/SHARE servers.
SAS Institute will expand the available access methods for the SAS ODBC Driver in
the future.

The SAS System SETUP program, first
available with Release 6.11 of the SAS
System for Windows and for OS/2 adds
features that simplify installation of the SAS
System. In addition, features of the SAS
System for Windows require that the
SETUP program be used for full functionality
of the SAS System on your PC. An automated mode of operation, new in 6.12,
makes enterprise installation of SAS System
software on Windows systems makes largescale installations manageable.

Both the local SAS ODBC server and the
SAS/SHARE server support multiple ODBC
client connections. The SAS ODBC Driver
provides level 1 API conformance and
minimum SQL grammar conformance and
does not support cursors.

Easily-selectable default installation types
are available to facilitate easy use of the
SAS System SETUP program for typical
users. A Typical configuration will install
the most commonly-used parts of all prod-

ENHANCEMENTS TO THE SAS SYSTEM SETUP PROGRAM

ucts for which you are licensed, and a
Compact configuration will install commonly-used parts of only the Base SAS
System.
A capability of the installation program for
the SAS System is called a CDROM installation. In this mode of operation, only a limited subset of SAS System files need to reside on the PC's hard drive or in a user's
network directory. Instead, all SAS System
files are accessed from the remote fileserver
or the SAS System CD-ROM. Only files
and data generated by the user need to be
stored on their own disk space.

Figure 6, SAS System SETUP selection screen
showing the main installation types.
Other enhancements include partial CDROM installation which allows a mixedmode installation between CD-ROM and
user disk, CD35 media that allows the
SETUP program to generate floppy diskette
images for non-networked installation onto
systems lacking CD-ROM drives, Uninstallation support, and improved logging and
detection of problems at installation time.

SUPPORT FOR WINDOWS NT
Release 6.12 is a full production release of
the SAS System for Windows, which fully
includes Windows NT. The Institute provides
two types of licenses for Windows NT users:
1.

The SAS System for Windows Workstations - a
license providing support for all Windows platforms
including Windows 3.1 using Win 32s, Windows 95
and Windows NT.

2.

The SAS System for Windows Enterprise - a license providing support for all Windows platforms
including Windows 3.1 using Win 32s, Windows 95,
Windows NT Workstation, and Windows NT Server.

A unified Windows image is shipped by the
Institute for the three Windows platforms
supported: Windows with Win32s, Windows
95, and Windows NT. At installation time
and at run-time, the SAS System will determine the type of system being used and
enable access to extended features available under advanced operating systems
such as Windows NT.
Under Windows NT, the SAS System automatically takes advantage of the 64-bit file
I/O features of the NT file system (NTFS).
As a result, you can create, sort, and subset
data sets and manipulate external files
greater than the 2 gigabyte size limit placed
on many other environments. The size limit
63
for a SAS data set on NTFS is 2
(9,223,372,036,854,775,808) bytes, with a
31
maximum of 2 (2,147,483,648) observations.
The SAS System under Windows NT supports a SAS/CONNECT Spawner. This
spawner allows a Windows NT machine to
service SAS/CONNECT remote requests
without requiring you to first log into the
Windows NT machine and execute the
spawner. Additionally, the spawner honors
the access rights of the Window NT registry
with respect to the requesting user.
In addition to these specific Windows NT
support areas, operation of the SAS System
on Windows NT benefits from NT-specific
features, including:
• recovery support such as automatic restart,
which in conjunction with the SAS/CONNECT
Spawner provides a high-availability platform
for NT SAS services.
• performance benefits from NTFS support for
disk striping, which allows several disk drives
to be used in parallel for decreased latency
• reliability benefits due to NT support for disk
mirroring and duplexing in addition to its recoverable, transaction-based nature.

• multi-session abilities resulting from NT support for multiprocessor machines.
• among Windows systems, Windows NT is the
only fully 32-bit operating system, which can
enhance performance in many types of applications.
• NT’s support for Volume Sets allows disk capacity to be added to existing volumes as
needed, without reformatting as storage needs
increase.
• Windows NT 4.0 increases performance over
NT 3.51 by 50-66% in some areas.
• Performance optimizations available on NT
Server 4.0 in the areas of task scheduling,
memory allocation, I/O throughput, and file
caching can lead to better performance on this
platform for large SAS applications.

For more details on the support provided for
Windows NT, refer to the paper “Comparing
the SAS System Release 6.11 for Microsoft
Windows 95 and Windows NT”.

CONCLUSIONS
This paper summarized some of the many
features available in Release 6.12 of the
SAS System for Personal Computers. New
features such as Print Preview and the SAS
System Viewer as well as incremental enhancements in other areas extend the
graphical user interface available with the
SAS System. In the areas of application
integration and SETUP program enhancements, improvements continue over previous releases.
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